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Read & Review 
 
Balancing PR Employee Accumulations 

READ 

PR Employee Accumulations need to be in balance prior to running any quarter or year-end 
processes. This process will ensure that the numbers reported for quarters and year-end are 
correct. The following is a list of reports and tips that you can use to balance quarterly and 
yearly. 

The reports used to balance the 941: 

 PR Employee Accumulations report (Eligible amounts for the deduction codes should 
tie to the taxable wage fields for Federal, Social Security, and Medicare) 

 PR Federal Tax Liability (Should tie to the Schedule B) 

 PR 940/941 Information (Uses FICA deduction for taxable wages) 

 PR 941 Schedule B (If an amount is missing for a date, check to make sure that the 
paid dates match the paid months by running the Employee Sequence Detail report 
and comparing it to the PR Check Register which has the paid date). See also KB: 
When the PR 941 Federal Form does not match the PR 941 Schedule B 

The reports used to balance FUTA/SUTA: 

 PR Employee Accumulations (Subject amounts for the deduction codes should tie to 
FUTA and SUTA wages in the YTD Gross column of the PR Unemployment Report. 
Eligible amounts will tie to the This Period Eligible column of the report.) 

 PR Employee Sequence Detail (Shows detail to look for incorrect calculations, 
overrides, or ignoring of limits) 

 PR Unemployment Report (Shows what will be included in the electronic file) 

 PR Tax Report (Helpful to run for any deduction/liability code) NOTE: check the Eligible 
amount on the FICA SS deduction and liability codes for individual employees to make 
sure the limit and calculation are correct (2023 limit is $160,200 and the rate is .062). 

 PR 940 Schedule A 

The reports used to balance Insurance/Workers' Compensation: 

 PR Employee Accumulations 

 PR Insurance Report by Insurance Code (Gross amount shows gross wages and 
Subject amount column includes all earnings subject to) 



 

 PR Tax Report (Helpful to run for any deduction/liability code) 

 

 

The reports used to balance W2: 

 PR Employee Accumulations (Subject amount for Federal wages, Eligible amount for 
Social Security, and Subject for Medicare wages) 

 PR W-2 Process | Options | Reports | PR W2 Preview Report 
 

REVIEW 

BALANCING PR EMPLOYEE ACCUMULATIONS 

BALANCING THE PR EMPLOYEE ACCUMULATION REPORT TIPS EMPLOYEE ACCUMULATIONS 

REPORT 

REASONS YOUR PR EMPLOYEE ACCUMULATIONS COULD BE OUT OF BALANCE VISTA 

PAYROLL: REPORTS - BALANCING QUARTERLY 

VISTA PAYROLL: QTR & YEAR END – BALANCING 

REPORTS TO USE TO BALANCE PAYROLL FOR QUARTERLY AND YEARLY PROCESSING 

 

Year End Check Runs/Bonus Checks 

READ  

It is important to process Payment Sequences for Pay Periods in order:  

Pay seq 1 needs to be processed before pay seq 2. If a bonus check (posted to pay 
seq 2) is processed before regular checks (in pay seq 1), a limit might be reached in 
the bonus sequence (e.g., (US-FICA), (Canada - CPP, EI)) and the regular payroll 
check will not consider/see that the limit has been met when you process the regular 
payroll check. This will cause the software to calculate again to meet the limit. To avoid 
this problem, post and process the regular payroll sequence (for example pay 
sequence 1) before processing the bonus check sequence (for example pay sequence 
2.) If Pay Sequences are processed out of order and checks issued, the YTD amounts 
on the pay stub will be incorrect.  

 

How to Process a Bonus Check 

1. From the Payroll module's Programs folder, open the PR Pay Period Control form.  

2. Click the Payment Sequence tab to set up a sequence for the bonus checks. In the 
PaySeq field, enter a unique number to create a new sequence.  

3. In the Description field, provide a description for the sequence, for example, Bonus 
Sequence.  

4. Check the Bonus checkbox to ensure that taxes are calculated according to the rate 
assigned to the associated deduction code.  



 

5. Save the record and close the form.  

6. From the Payroll module's Programs folder, open the PR Deductions/Liabilities form.  

7. In the Dedn/Liab Code field, enter the deduction code, or press F4 to select the code 
from a list. On the Info tab, if you have the Calculate as a rate of gross on bonus 
sequence box checked and a rate specified in the Bonus Rate field, this rate is used to 
calculate the deduction. If this box is not checked, the normal routine or rate is used.  

8. Click the Basis Codes tab. If you have a special earning code for bonuses, be sure that 
it is assigned to the basis codes for all appropriate deductions and liabilities.  

9. Process the payment sequences within the pay period in order.  

NOTE: If a bonus check is processed before regular checks, a limit might be reached in the 
bonus sequence (e.g., FICA). To avoid this problem, post and process the regular payroll 
sequence before processing the bonus check sequence. Optionally, you could put the 
bonus checks in a separate, one-day pay period with a week ending date less than the 
normal payroll.  

 

Consider which employee based deductions and liabilities you want to calculate and add the 
appropriate frequency codes to PR Pay Period Control.   

 

NOTE: If pay sequences are processed out of order, the YTD amounts on the pay stub will be 
incorrect.  

 

If you do not want the employee-based deductions (such as HSA, Medical, and Dental) to 
deduct from the bonus payments, consider using unique frequency codes for the Bonus pay 
sequence and only activate the ones you want for the bonus checks;  

 

OR  

 

Click the box in PR Deductions/Liabilities titled Calculate on pay sequence #1 only. On a 
routine based deduction, such as FWT, make sure the Use YTD accumulations to correct 
rounding errors is unchecked. You never want to check that box on a routine based deduction 
anyway but especially when doing your bonus sequence.   

 

You can issue live bonus checks for all employees that normally receive direct deposit by 
opening the PR Pay Period Control form and checking the OverrideDirDep checkbox for the 
sequence on the Payment Sequence tab. You can also open the PR Employee Pay Seq 
Control form and from the File menu, select Payment Method Override to change the pay 
method from EFT to check for the bonus sequence, IF all employees are to receive checks on 
the bonus sequence. IF some but not all should receive checks, change payment method on 
each employee individually within the PR Employee Pay Seq Control form.  

 

You can also handle bonuses by adding a stand-alone pay period for 1 day such as 12/31/23 
to 12/31/23, but you still need to process all pay periods in order. For example, a pay period 
ending 12/30/23 would need to be processed and paid prior to pay period ending 12/31/23. 

 

 

REVIEW 

YEAR-END BONUS CHECKS FREQUENTLY ASKED QUESTIONS 



 

DOES VISTA PROVIDE A PAYROLL YEAR END WORKFLOW CHECKLIST ANYWHERE? 

YEAR END PAYROLL CHECKS LAST WEEK OF DECEMBER 

 

 

Taxable Fringe (Car Allowance, Life Insurance, Etc.) 
READ 

Before starting the process of increasing the employee's taxable wage, you will need to 
determine what taxes you want to withhold and what taxes you want to add to the subject 
taxable wages but not withhold at this time.  
For example, you may want to calculate the FICA deduction and liability to increase the FICA 
subject and eligible and calculated amounts. For federal tax you may want to add the taxable 
wages to the subject and eligible amount but not calculate the federal amount for the taxable 
fringe.  
Often, Federal and State taxes will not be deducted. This indicates the Car Allowance earnings 
as taxable for W-2 purposes, but the taxes will not be withheld.  
Increase an Employee's Taxable Wages  
For a company paid benefit such as auto allowance or insurance, please see the following 
examples.  
 
Use the following instructions to set up a sample Car Allowance earnings where taxes 
will be deducted from the employee's current paycheck. At a minimum, the FICA portion 
of the Car Allowance earnings will be withheld, but other taxes can also be withheld at 
this time. The Car Allowance earnings will be reported on the employee's W-2 as well as 
any other taxes deducted from the employee's current paycheck.  

  
 
STEP 1 - Create an earnings code for Taxable Fringe  

1. From the Payroll module's Programs folder, open the PR Earnings Codes form.  

2. Click the New Record icon.  

3. In the Earnings Code field, enter a new code number. You can view existing earning 

codes by pressing F4.  

4. Click the Info tab.  

5. In the Description field, enter a description for the code, for example, Car Allowance.  

6. From the Method drop-down list, select Amount.  

7. In the Factor field, enter 1.00.  

8. Check the True Earnings for Payroll Reports checkbox.  

9. In the Earnings Type field, press F4 to select the appropriate earnings type (this 

controls what GL Account will be used for the earnings).  



 

10. In the CT field, enter the Job Cost Type, or press F4 to select a cost type from a list.  

11. Click the Deductions/Liabilities tab.  

12. Add the Deduction Codes for all taxes to which the car allowance is subject. Generally 

this would include Federal Withholding, FICA, and State Withholding.  

13. Add the FICA liability codes, and determine if any additional deductions and/or liabilities 

(i.e. FUTA, SUTA) are required.  

14. Check the Subject Only box on taxes that will not be withheld at this time for the Car 

Allowance earnings. Often, the Federal and State taxes will not be deducted. This 

indicates the Car Allowance earnings are taxable for W-2 purposes, but the taxes will not 

be withheld.  

STEP 2 - Set up a deduction code for a reversal of the car allowance  

1. From the Payroll module’s Programs folder, open the PR Deductions/Liabilities form.  

2. Click the New Record icon.  

3. In the Dedn / Liab Code field, enter a new code number. You can view existing earning 

codes by pressing F4.  

4. In the Description field, enter a description of the code.  

5. Select Deduction as the Type.  

6. From the Calculation Category drop-down list, select E-Employee.  

7. In the GL Account field, enter the credit account number, or press F4 to select an 

account from a list.  

8. From the Method drop-down list, select G - Rate of Gross.  

9. Enter the rate of 1.00 in Rate/Amount #1 and #2 fields.  

10. Click the Basis Codes tab.  

11. Add the Car Allowance earning code from Step 1 (above) in the grid for this deduction 

code.  

 
STEP 3 - Add the new deduction code to the employee  

1. From the Payroll module’s Programs folder, open the PR 

Employee Dedns/Liabs form.  

2. In the Employee field, press F4 to select the employee from a list.  

3. In the Dedn / Liab Code field, enter the deduction code created in Step 2 above, or 

press F4 to select the code from a list.  

4. Click the Info tab.  

5. Check the Employee-Based checkbox.  



 

6. In the Frequency field, enter the appropriate frequency code, or press F4 to select a 

code from a list (this is used to tell the system during payroll processing that these 

earnings should be included).  

7. In the Processing Seq. # field, enter 1.  

8. Click Save.  

STEP 4 - Add the frequency code for the taxable fringe deduction  

1. From the Payroll module’s Programs folder, open the PR Pay Period Control form.  

2. Click the Active Frequency Codes tab.  

3. Add the Frequency Code assigned to the Car Allowance deduction in Step 3 above.  

4. Save the record.  

5. From the Payroll module’s Programs folder, open the PR Timecard Entry form.  

6. Enter an employee timecard line using the earnings code created in Step 1 above, using 

the amount for the Car Allowance.  

7. Post the remaining regular timecard entries for the employee if they are within the 

current pay period.    

STEP 5 - Process your payroll as you would normally  

Verify the Car Allowance is correct prior to printing checks if this is a current pay period. You will 
see the Car Allowance amount appear in both earnings and deductions.  
Use the following instructions to set up a Car Allowance where the earnings need to be 
reported on the employee's W-2's, no Federal or State taxes will be withheld, and the 
Employee's FICA tax obligation will be paid by the Employer.  
  
STEP 1 - Create an earnings code for Car Allowance  

1. From the Payroll module's Programs folder, open the PR Earnings Codes form.  

2. Click the New Record icon.  

3. In the Earnings Code field, enter a new code number. You can view existing earning 

codes by pressing F4.  

4. Click the Info tab.  

5. In the Description field, enter a description for the code, for example, Car Allowance.  

6. From the Method drop-down list, select Amount.  

7. In the Factor field, enter 1.00.  

8. Check the True Earnings for Payroll Reports checkbox.  

9. In the Earnings Type field, press F4 to select the appropriate earnings type (this 

controls what GL Account will be used for the earnings).  

10. In the CT field, enter the Job Cost Type, or press F4 to select a cost type from a list.  



 

11. Click the Deductions/Liabilities tab.  

12. Add the Deduction Codes for all taxes to which the car allowance is subject. Generally 

this would include Federal Withholding, FICA, and State Withholding.  

13. Add the FICA liability codes, and determine if any additional deductions and/or liabilities 

(i.e. FUTA, SUTA) are required.  

14. Check the Subject Only box on taxes that will not be withheld at this time for the Car 

Allowance earnings. Often, the Federal and State taxes will not be deducted. This 

indicates the Car Allowance earnings are taxable for W-2 purposes, but the taxes will not 

be withheld.  

STEP 2 - Set up a new Garnishment Group for Car Allowance  

1. From the Payroll modules' Programs folder, open the PR Garnishment Groups form.  

2. Click the Deductions/Earnings tab.  

3. Add the deduction codes for FICA.  

4. Add the earnings code for Car Allowance set up in Step 1 above.  

 
STEP 3 - Set up a deduction code for a reversal of the Car Allowance  

1. From the Payroll module’s Programs folder, open the PR Deductions/Liabilities form.  

2. Click the New Record icon.  

3. In the Dedn / Liab Code field, enter a new code number. You can view existing earning 

codes by pressing F4.  

4. In the Description field, enter a description of the code.  

5. Select Deduction as the Type.  

6. From the Calculation Category drop-down list, select E-Employee.  

7. In the GL Account field, enter the credit account number, or press F4 to select an 

account from a list.  

8. From the Method drop-down list, select N - Rate of Net.  

9. In the Garnishment Group field, enter the garnishment group created in Step 2 above.  

10. Enter the rate of 1.00 in Rate/Amount #1 and #2 fields.  

11. Click the Basis Codes tab.  

12. Add the Car Allowance earning code from Step 1 (above) in the grid for this deduction 

code.  

 
STEP 4 - Add the new deduction code to the employee  



 

1. From the Payroll module’s Programs folder, open the PR 

Employee Dedns/Liabs form.  

2. In the Employee field, press F4 to select the employee from a list.  

3. In the Dedn / Liab Code field, enter the deduction code created in Step 3 above, or 

press F4 to select the code from a list.  

4. Click the Info tab.  

5. Check the Employee-Based checkbox.  

6. In the Frequency field, enter the appropriate frequency code, or press F4 to select a 

code from a list (this is used to tell the system during payroll processing that these 

earnings should be included).  

7. In the Processing Seq. # field, enter 1.  

8. Click Save.  

 
STEP 5 - Set up a new sequence that is separate from the usual payroll run  

1. From the Payroll module’s Programs folder, open the PR Pay Period Control form.  

2. Click the Active Frequency Codes tab.  

3. Add the Frequency Code assigned to the Car Allowance deduction in Step 3 above.  

4. Save the record.  

5. Post the remaining regular timecard entries for the employee if they are within the 

current pay period.   

STEP 6 - Create a new batch using the new sequence number  

1. From the Payroll module’s Programs folder, open the PR Timecard Entry form.  

2. Create a new batch using the sequence number created in Step 5 above.  

3. Enter an employee timecard using the earnings code created in Step 1 above, using the 

amount for the Car Allowance.  

4. From the File menu, select Batch Process.  

5. Post the batch.  

STEP 7 - Process the pay period and payment sequence  

1. From the Payroll module's Programs folder, open the PR Payroll Process form.  

2. Process this pay period and payment sequence using the option for Employees with 

Changed Earnings or Overrides.  

 
STEP 8 - Change the payment method for each employee with Car Allowance  



 

1. From the Payroll module’s Programs folder, open the PR Employee Pay Seq Control 

form.  

2. For each employee with Car Allowance, perform the following 4 steps:  

 Change the Payment Method to X-No Pay  

 Update the Paid Date field  

 Update the Paid Month field  

 Click Process  

Finish standard processing and closing procedures for this sequence.  

 

REVIEW 

Vista Year-End Taxable Fringe Frequently Asked Questions  

 
Leave Reset 
READ 

 
At the end of the year, you must perform a Leave Reset to reset your accrual and available 
balance limits to zero. The accrual is going to bank the allotted hours to the employees’ 
available balance including the amount of carry over.  
 
Example of the Standard Leave Code vs. Employee Overrides  

Thomas is an employee who needs editing prior to the reset because he accrues time faster 
(because of longevity) than the standard accrual.  
 
View the standard leave code setup below for Thomas' employer:  

 The monthly accrual of time (Accrual Limit #1) is 6.67 hours  

 The annual accrual of time (Accrual Limit #2) is 80.00 hours  

 The Carryover Limit is 20.00  

 
If an employee (Ex: Thomas Carr) accrues more hours than the standard limits, you must enter 
override amounts on the PR Employee Leave form for that employee (and all other employees 

that do not follow the standard limits). In this example (based on the standards in the above 
example), Thomas Carr needs editing prior to the reset for two reasons:  

1. Thomas has been with the company for 4 years and moved from the standard leave 

code setup of 80 hours a year to 120 hours a year.  

 10.00 is entered in the Accrual Limit #1, Employee Override field. That means 

Thomas will accrue 10 hours a month (not the standard 6.67).  



 

 120.00 is entered in the Accrual Limit #2, Employee Override field. That 

means yearly, Thomas will accrue a maximum of 120 hours a year (not the 

standard 80.00).  

2. If you look at the example above, employees can carryover 20 hours each year. Thomas 

has 10.00 hours of carryover.  

 120.00 is the annual limit for Thomas, + 10.00 carryover means that 130.00 is 

entered in the Balance Limit Employee Override field. 

  
Step 1 - Override All Employees that Do Not Have the Standard Leave Code  

3. From the Payroll module's Programs folder, open the PR Employee Leave form.  

4. In the Employee field, enter the employee number or press F4 to select an employee 

from a list.  

5. In the Leave Code field, enter the leave code or press F4 to select a leave code from a 

list.   

6. Click the Info tab.  

7. In the Accrual Limit #1 section of the tab, enter the new limit amount in the Employee 

Override field. The rate at which these hours are accrued is based on 

the Frequency set up for the selected Leave Code. In our example, these hours accrue 

on a Monthly basis.  

8. In the Accrual Limit #2 section of the tab, enter the new limit amount in the Employee 

Override field. The rate at which these hours are accrued is based on 

the Frequency set up for the selected Leave Code. In our example, these hours accrue 

on a Yearly basis.  

9. In the Balance section of the tab, enter the new limit amount (balance + any allowed 

carryover) in the Employee Override field. For example, if employees can carryover up 

to 20 hours each year, include the unused hours up to 20. In our example below, 

Thomas has 10.00 hours of carryover, so his yearly limit is 130 (Accrual Limit #2 

Override of 120 + Carryover of 10.  

  
Step 2 - Create and Process Batch to Reset Amounts to 0.00  
All Resets must have a date one day prior to any dates with Usage or Accruals.  
Example:  If the Reset Date is 12/31/23, then usage and accruals will start on 1/1/24 for 2024.  
If there is usage for 2023 on 12/31/23, the reset date must be 1/1/24 and usage and accruals 
will start on 1/2/24.  

  

1. From the Payroll module’s Programs folder, open the PR Leave Entry form.  

2. In the Batch Month field, enter 12/23.  

3. Click OK. 



 

4. Click File | Leave Code Reset 

5. Check the Reset Accrual Amounts to 0.00 hours for the next frequency period 

checkbox.  

6. Check the Reset Available Balances to Carryover Limit checkbox.  

7. In the Reset Date field, enter the date of the reset. All resets must use a date one day 

prior to any days with usage or accruals.  

  

Example:  If the Reset Date is 12/31/23, then usage and accruals will start on 1/1/24 for 

2024. If there is usage for 2023 on 12/31/23, the reset date must be 1/1/24 and usage 

and accruals will start on 1/2/24.  

8. In the Leave Code and Frequency sections of the form, specify whether All or 

a specific code or frequency is to be reset.  

9. Click Update then Close.  

10. Click File | Process Batch.   

11. Click Validate to check for errors.  

12. Click Preview to display an audit report showing the reset entries. If entries are correct, 

click Post Batch. If changes are required:  

a. Close the audit report form.  

b. From the Payroll module’s Programs folder, open the PR Leave Entry form.  

c. Select the batch you just created.  

d. Using the Grid tab, update the fields as needed, or select a row and then click 

the X to delete it.  

e. Click Save.  

f. Process the batch again.  

 
If you have posted the batch and you notice that the batch is incorrect, you must reverse 
the batch transactions.  

1. From the Payroll module’s Programs folder, open the PR Leave Entry form.  

2. In the Batch Month field, enter the date of the original reset transactions.  

3. Click OK.  

4. Click File | Leave Code Reset 

5. In the PR Leave Code Reset form, check the Reset Accrual Amounts to 0.00 hours 

for the next frequency period checkbox.  



 

6. Check the Delete any reset transactions currently posted to this date checkbox to 

reverse the leave reset transactions. This process pulls the previously reset transactions 

into a new batch and flags all of them for deletion.  

7. Click Update then Close.  

8. Click File | Process Batch.   

9. Click Validate to check for errors.  

10. Click Preview to display an audit report showing the reset entries. If entries are correct, 

click Post Batch. 

11. When the batch is processed, all reset transactions in the batch are removed from 

the Leave History table, the Last Date Reset values in PR Employee Leave are set to 

null, and the Accrual Limits and Available Balance Limits are set to the previous 

values.  

  
Step 3 - Review Balances  
After you have reset leave balances, from the Payroll module’s Reports folder, review the 

following reports:  

 PR Employee Leave Balance and Accumulations  

 PR Employee Leave History Detail  

 

REVIEW 

YEAR-END LEAVE RESET FREQUENTLY ASKED QUESTIONS RESETTING YEAR END 

LEAVE 

 

Tax Updates/Updated Rate & Limits 
READ 

 
Tax Routine Updates  

The Viewpoint Development Team upon notification completes updates to all Tax Routines. 
Notifications come from either the state or the customer notifies us.   
  
1. Locate and Install the Most Recent Tax Update  

1. Visit the Customer Portal Vista Downloads page and navigate to Tax Updates for 2024.  

2. Locate and load the last update available.  

3. Follow the Tax Update installation steps provided in the document found with your 

update file. 

Note: Tax updates are inclusive and include all previous updates for the current year.  

  
2. Initialize Tax Update for Each Payroll Company  

https://support.viewpoint.com/s/product-more-resources?product=Vista&type=Downloads&links=true&title=Downloads%20for%20Vista


 

1. From the Payroll module's Programs folder, open the PR Routine Master form.  

2. From the File menu, select Initialize.  

  
3. Check for the Latest Tax Routine  

1. From the Payroll module’s Programs folder, open the PR Routine Master form.  

2. In the Routine field, press F4, and then select Federal Income Tax.  

3. Look at the value in the Procedure Name field to make sure it ends in the current year.  

  
4. Update Rates and Limits  
You are responsible for updating any new rates and or limits for 2024.  
If you are updating a rate on a deduction and there is an associated liability, the rate will need to 
be updated there as well. To update deductions and/or liabilities:  

1. From the Payroll module's Programs folder, open the PR Deductions and 

Liabilities form.  

2. In the Dedn / Liab Code field, enter the code number you want to update, or press F4 to 

select the code from a list.  

3. On the Info tab, update the rates as needed, and then save the record.  

To update Workers Compensation and/or General Liabilities:  

1. From the Payroll module's Programs folder, open the PR State Insurance Codes 

form.  

2. In the State field, enter the abbreviation for the state you want to update, or press F4 to 

select the state from a list.  

3. In the Insurance Code field, enter the code number you want to update, or press F4 to 

select the code from a list.  

4. On the Dedn / Liab tab, update the rates as needed, and then save the record.  

 

REVIEW 

PAYROLL: QTR & YEAR-END - UNEMPLOYMENT 

YEAR-END TAX UPDATES FREQUENTLY ASKED QUESTIONS HOW DO I INITIALIZE MY 

TAX ROUTINES 

HOW TO CHANGE THE NEW PERCENTAGE OR RATE FOR STATE UNEMPLOYMENT 

 

ADP File Generation 
READ 

Tax Code List (to ADP)  

1. User Database \ ADP Payroll - Configuration - For any company being reported, check 

the 'Pre-note all next run?' checkbox, and save the form: 



 

(NOTE: this only needs to be done once, even if multiple companies are being included 
in this file)." 

2. Allow the scheduled Integration job to generate the files into the Network Share setup by 

your IT department.  

OR 
If you are an Authorized Control Flag User (as specified in User Database \ ADP Payroll 
- Configuration form), click the 'Generate ADP File(s)' button on this form. 

3. Check your Network Share location (from step 2 above) for the appropriate Wage 

Payment reporting file. 

Depending on the number of companies/employees reporting to ADP, this file may take up to 
several minutes to generate. 
Actual filename will depend on your individual configuration. See User Database \ ADP Tax - 
Configuration form for the Periodic file name. 
The interface will create a pre-note file for all Active (Non-Terminated) employees who have at 
least one active Direct Deposit account specified in PR Employees. 
 
Periodic Tax File 

1. PR Pay Period Control - For the Pay Period(s) being reported, once normal Payroll 

Processing has been completed, check the Ready for ADP Tax checkbox and save. 

Repeat for all Companies, PR Groups, and Payroll End Dates that apply. 

2. Allow the scheduled Integration job to generate the files into the Network Share setup by 

your IT department.  

OR 
If you are an Authorized Control Flag User (as specified in User Database \ ADP Tax - 
Configuration form), click the 'Generate ADP File(s)' button on this form. 

3. Check your Network Share location (from step 2 above) for the appropriate Periodic 

reporting file and its associated "CNTRL_RPT_..." file. 

Depending on the number of companies/employees reporting to ADP, this file may take up to 
several minutes to generate. 
Actual filename will depend on your individual configuration. See User Database \ ADP Tax - 
Configuration form for the Periodic file name. 
 
Quarterly Tax File  

1. In User Database \ ADP Tax - Configuration, enter the ending date for the quarter in the 

Next Quarter to Run field and Save. 

(e.g., for Q2 2024, enter 6/30/24 in this field)" 

2. Allow the scheduled Integration job to generate the files into the Network Share setup by 

your IT department.  

OR 
If you are an Authorized Control Flag User (as specified in User Database \ ADP Tax - 
Configuration form),  click the 'Generate ADP File(s)' button on this form. 

3. Check your Network Share location (from step 2 above) for the appropriate Quarterly 

reporting file and its associated "CNTRL_RPT_..." file. 



 

Depending on the number of companies/employees reporting to ADP, this file may take up to 20 
- 30 minutes to generate. 
Actual filename will depend on your individual configuration. See User Database \ ADP Tax - 
Configuration form for the Periodic file name. 
 
Interim (Monthly) File  

1. In User Database \ ADP Tax - Configuration, enter the starting date for the month in the 

Monthly Salary to Run field and Save. 

(e.g., for June 2024, enter 6/1/24 in this field)" 

2. Allow the scheduled Integration job to generate the files into the Network Share setup by 

your IT department.  

OR 
If you are an Authorized Control Flag User (as specified in User Database \ ADP Tax - 
Configuration form), click the 'Generate ADP File(s)' button on this form. 

3. Check your Network Share location (from step 2 above) for the appropriate Quarterly 

reporting file and its associated "CNTRL_RPT_..." file. 

NOTE: the filename will appear similar to your Quarterly Report files, but will be several orders 
of magnitude smaller in file size. Whereas a full Quarter report may be 1 - 2 Megabytes-MB in 
size (1,024 - 2,048 Kilobytes-KB) or more, an Interim (Monthly) file may be 150 Kilobytes-KB or 
less. 
Depending on the number of companies/employees reporting to ADP, this file may take up to 
several minutes to generate. 
Actual filename will depend on your individual configuration. See User Database \ ADP Tax - 
Configuration form for the Periodic file name. 
 
Wage Payment File 

1. PR Pay Period Control - For the Pay Period(s) being reported, once normal Payroll 

Processing has been completed, check the Ready for ADP Payroll checkbox and Save. 

Repeat for all Companies, PR Groups, Payroll End Dates that apply. 

2. Allow the scheduled Integration job to generate the files into the Network Share setup by 

your IT department.  

OR 
If you are an Authorized Control Flag User (as specified in User Database \ ADP Tax - 
Configuration form), click the 'Generate ADP File(s)' button on this form. 

3. Check your Network Share location (from step 2 above) for the appropriate Wage 

Payment reporting file. 

Depending on the number of companies/employees reporting to ADP, this file may take up to 
several minutes to generate. 
Actual filename will depend on your individual configuration. See User Database \ ADP Tax - 
Configuration form for the Periodic file name. 
 
Wage Payment Pre-Note 

1. User Database \ ADP Payroll - Configuration - For any company being reported, check 

the 'Pre-note all next run?' checkbox, and save the form: 



 

(NOTE: this only needs to be done once, even if multiple companies are being included 
in this file)." 

2. Allow the scheduled Integration job to generate the files into the Network Share setup by 

your IT department.  

OR 
If you are an Authorized Control Flag User (as specified in User Database \ ADP Payroll 
- Configuration form), click the 'Generate ADP File(s)' button on this form. 

3. Check your Network Share location (from step 2 above) for the appropriate Wage 

Payment reporting file. 

Depending on the number of companies/employees reporting to ADP, this file may take up to 
several minutes to generate. 
Actual filename will depend on your individual configuration. See User Database \ ADP Tax - 
Configuration form for the Periodic file name. 
The interface will create a pre-note file for all Active (Non-Terminated) employees who have at 
least one active Direct Deposit account specified in PR Employees. 

 

REVIEW 

FILE GENERATION CHECKLIST FOR ADP 

Third Party Sick Pay 
READ 

This example shows how to set up and process Third Party Sick Pay wages and assumes that 
the third party payer deducts the employee portion of FICA and Medicare tax and transfers the 
employer portion tax liability to your company.  
  
STEP 1 - Set up a New Earnings Code  

1. From the Payroll module's Programs folder, open the PR Earnings Codes form.  

2. Click the Grid tab to view existing earnings codes.  

3. Click the Info tab.  

4. In the Earnings Code field, enter a new number for the earnings code.  

5. In the Description field, enter a description, such as 3rd Party Sick Pay.  

6. From the Method drop-down list, select A-Amount.  

7. In the Factor field, enter I.00.  

8. Check the Include in Liability Distributions box.  

9. In the Earnings Type field, press F5 to open the HQ Earn Types form.  

10. Click the Grid tab to view existing earnings types.  

11. Click the Info tab.  

12. In the Earnings Type field, enter a new number for the earnings type.  

13. In the Description field, enter a description, such as 3rd Party Sick Pay.  



 

14. Save the record, and close the HQ Earn Types form.  

15. In the Earnings Type field on the PR Earnings Codes form, enter the new earnings 
type or press F4 to select it from a list.  

16. In the CT field, enter the cost type for Labor or press F4 to select it from a list.  

17. Save the record.  

18. Click the Dedn / Liabs tab.  

19. Add all the deductions and liabilities to be calculated when processing 3rd Party Sick 
Pay.  

20. Check the Subject Only checkbox for any DL Code that should be calculated and 

added to subject wages for W-2 reporting but do not calculate for eligible amounts.  
  
STEP 2 - Add the Earning Type to the Department Master  

1. From the Payroll module's Programs folder, open the PR Department Master form.  

2. In the Department field, enter the department number to which 3rd Party Sick Pay is to 
be posted or press F4 to select the department from a list.  

3. Click the Earnings Types tab.  

4. In the Earn Type field, add the 3rd Party Sick Pay earnings type created in Step 1 

above.   

5. In the Earnings Expense field, enter a GL Account used to pass through 3rd Party Sick 
Pay earning and deduction amounts or press F4 to select an account from a list.  

6. Save the record.  
  
STEP 3 - Set Up a New Deduction Code  
We will use this code to offset amounts posted to the earning code in Step 1, since we are not 
paying cash to the employee for those earnings.  

1. From the Payroll module's Programs folder, open the PR Deductions/Liabilities form.  

2. Click the Info tab.  

3. In the Dedn / Liab Code field, enter a number for the new deduction code. To view 
existing code numbers, press F4.  

4. In the Description field, enter a description, such as 3rd Party Sick Pay Offset.  

5. For Type, select Deduction.  

6. From the Calculation Category drop-down list, select A-Any or E-Employee.  

7. In the GL Account field, enter the GL account number used in Step 2 above.  

8. From the Method drop-down list, select N-Rate of Net. The Garnishment Group field 

displays.  



 

9. In the Garnishment Group field, press F5 to open the PR Garnishment Groups form.  

10. Create a garnishment group called 3rd Party Sick Pay. On 
the Deductions/Earnings tab, use the grid to enter the earnings code created in Step 1 

above and add any other deductions that are to be taken from those earnings.   

11. Close the PR Garnishment Groups form.  

12. In the Garnishment Group field, enter the newly created group number.  

13. In the Rate / Amount #1 and #2 fields, enter 1.00. 

14.  CAUTION: Do not check the Use YTD accumulations to correct rounding errors box 
on the PR Deductions/Liabilities form for any deduction or liability that you have 
overridden in this process. If the flag is checked, the deduction or liability will try to 
correct itself when the next payroll is processed.  

  
STEP 4 - Assign the Deduction Code to the Employee  

1. From the Payroll module's Programs folder, open the PR 
Employee Dedns/Liabs form.  

2. In the Employee field, enter the number of the employee to which you want to assign 
the deduction code or press F4 to select the employee from a list.  

3. In the Dedn/Liab Code field, enter the number of the 3rd party sick pay code created in 
Step 3 or press F4 to select the code from a list.  

4. On the Info tab, check the Employee based box.  

5. In the Frequency field, enter A - Always or press F4 to select it from a list. The 
deduction will only calculate when there are earnings processed using the 3rd Party Sick 
Pay code.  

6. In the Processing Seq # field, enter 1.  

7. Save the record.  
  
STEP 5 - Enter a Timecard to Record the Amount of 3rd Party Sick Pay Earnings  

1. From the Payroll module's Programs folder, open the PR Timecard Entry form.  

2. Select Create a New Batch.  

3. Enter a Batch Month.  

4. Enter the appropriate PR Group, PR End Date, and Pay Seq.  

5. Click OK.  

6. On the Grid tab, use the Employee field to enter the number of the employee you want 
to add to the timecard, or press F4 to select the employee from a list.  

7. In the (0) Phase field, enter the phase number for the job phase, or press F4 to select it 

from a list.  



 

8.  In the (1) EC field, enter the earnings code for Third Party Sick Pay, or press F4 to 

select it from a list.  

9. In the Amount field, enter the amount paid by the 3rd party administrator.  

10. Save the record.  

11. Repeat as needed for each employee.  

12. From the File menu, select Process Batch.  

13. Click Validate to check for errors.  

14. Click Preview to make sure timecard lines are correct.  

15. Click Post.  

  
STEP 6 - Process the Pay Period  
In this example, since the 3rd Party Sick Pay provider has deducted the FICA and Medicare 
already, we need to zero these calculations out.  

1. From the Payroll module's Programs folder, open the PR Employee Pay Seq 
Control form.  

2. Click the Deductions tab.  

3. In the PR Group field, enter the PR group number, or press F4 to select it from a list.  

4. In the Employee ID field, enter the employee number, or press F4 to select it from a list.  

5. In the Pay Seq# field, enter the pay sequence number, or press F4 to select it from a 

list.  

6. In the grid below, click the Override box for each of the deductions, leaving 
the Override Amount fields at zero.  

7. Click the Info tab.  

8. Click Process.  

9. From the Payment Method drop-down list, select X-No Pay.  

10. Provide a Paid Date and Paid Month.  

11. Click Process.  

 

 

 

REVIEW 

YEAR-END THIRD PARTY SICK PAY FREQUENTLY ASKED QUESTIONS 3RD PARTY 

SICK PAY ON THE W-2 

WHAT DOES THE THIRD PARTY SICK PAY INDICATOR IN THE W-2 PROCESS FORM 
DO? 



 

 

W-2 
READ 

STEP 1 - Set Tax Year, Contact Info, and More  

1. From the Payroll module’s Programs folder, open the PR W-2 Process form.  

2. In the Tax Year field, enter the current tax year.   

3. Click the Info tab.  

4. If you have third party sick pay, check the Third Party Sick Pay Indicator checkbox.  

5. From the Options to Initialize Retirement Plan box section of the form, select the 

correct option (if applicable).  

6. Save the record.  

7. Click Initialize Header. The header will initialize, populating the company information on 
the form. Make sure a valid email address exists in case the IRS needs to contact you.  

  
STEP 2 - Enter Additional Tax Information  

 
Note: This step is for Maryland Users Only  

1. On the PR W-2 Process form, click the Add'l Info tab.  

2. Enter the required information on this form. For information about a specific field, place 
your cursor in the field and press F1.  

  
STEP 3 - Add IRS Items Needed for Reporting and Map to a Deduction  

1. On the PR W-2 Process form, click the Federal Information tab. For information about 
a specific field, place your cursor in the field and press F1.  

2. Review, add, or edit items. If this is your first year using Vista, the items list is blank, and 
you will have to enter them manually. If you have previously processed W-2s in Vista, 
you may need to add or modify items in the list.   

3. To select an item, place your cursor in the Item field and press F4. To select a deduction 
code for mapping, place your cursor in the Deduction field and press F4.  

  
Note: Add any Misc. Box 14 items that need to be reported on the Federal W-2.  
  
Item 1 is for reporting Federal Wages on the W-2.  The wages will appear in the W-2 

in box 1. The system will use the subject amount found in PR Employee Accumulations 
for the Federal Deduction and place it in box 1 on the W2.  
  
Item 2 is the Federal Tax Withheld and the system will use the amount found in the PR 
Employee Accumulation under the Federal Deduction and place it in box 2.  
  
Item 3 is Social Security Wages.  They system will use the eligible amount found in PR 



 

Employee Accumulations under the FICA Deduction and place it in box 3.  
  
Item 4 is the FICA Amount withheld and the system will use the Amount found in the PR 
Employee Accumulations under the FICA Deduction and place it in box 4.  
  
Item 10 is Deferred Comp - 401(k) you will want to map your 401k Deduction or 
Negative Earnings to have the Amount show on the W-2 in box 12 where a D will be 
placed beside the amount.  

4. Map the following items to the following deductions:  
  
Item 1 to Deduction 1 to report Federal Wages  
Item 2 to Deduction 1 to report the amount of Federal Tax Withheld  
Item 3 to Deduction 2 to report FICA Wages  
Item 4 to Deduction 2 to report the FICA Amount Withheld  
Item 10 to your 401K deduction code to report the 401k Amount Withheld  

5. Click Initialize Federal to import federal amounts.   

  
STEP 4 - Add and Assign State and Local Deduction Codes   
State and local deduction codes default into the form based on the information from the PR 
State Information and PR Local Code Setup forms.  

 
1. Within the PR Deductions/Liabilities form ensure that an Aatrix Tax Type is selected 

for all state and local deduction codes that you need to include on your W2s. This is 
done in the Add’l Info tab section of the PR Deductions/Liabilities form and is 

required. Deductions without an Aatrix Tax Type will not be included in Aatrix and on 
your W2s. 

2. On the PR W-2 Process form, click the State/Local Information tab. For information 
about a specific field, place your cursor in the field and press F1.  

3. Review, add, or edit items as needed. If this is your first year using Vista, click Initialize 
State to import state and local codes. If you have previously processed W-2s in Vista, all 

of your codes display.  

4. Check or un-check the Initialize box for each State and/or Local Code as needed.  

5. Click Initialize State to reimport all selected state and local codes.  
  
STEP 5 - Add Applicable State Reportable Items   

1. On the PR W-2 Process form, click the State Box 14 Information tab. For information 
about a specific field, place your cursor in the field and press F1.  

2. Add or modify any applicable miscellaneous state reportable items.   

3. Click Initialize State Box 14.  

  
STEP 6 - Make Employee Edits  

Once all tabs have been initialized, a list of employees displays on the Employees tab.  



 

1. On the PR W-2 Process form, click the Employees tab. The employee information 
shown here may be edited by double-clicking the Employee line to open the PR W-2 
Employee Edit form.  

2. Once the form is open you may modify the information on any of the tabs as needed. 
Modified information updates only the W-2 tables. Press F1 from any field for more 

information.  

3. Save the record.  
 

STEP 7 - W-2 Preview 
To preview your W2 data:  

1. Click on Options | Reports | PR W2 Preview Report 

 

 

2. Specify the parameters for which you want to view the report.  

3. Click Preview to display a report that shows each employee and a company total. It will 

also show you a W-2 count. Take into consideration this is for Federal only so please 
add count for additional copies needed.  

 
 
Employee Record:  

 



 

 
  
 
 
 
 
 
 
Company Totals Record with Count:  

 
 
 
STEP 8 – Print or Electronically File 

To print or electronically file W-2 statements you can use the Vista W-2 Process form to 
generate a federal electronic file. State and local files must be filed via Aatrix. Federal files can 
be filed via Aatrix as well. 



 

Federal Filing through Vista 

 
1. From the main menu, select Payroll > Programs > PR W-2 Process. The PR W-2 

Process form opens. 

 
2. In the Tax Year field, enter the tax year for which to generate the federal W2 electronic 

file. 
 

3. Select Tasks > Generate W-2 e-File.The PR Generate W-2 e-File form opens. 

 

 
 

4. If any of your employees received sick pay from an insurance company or other third-
party and you were notified of the sick pay amount, enter that amount in the Third Party 
Income Tax Withholding field. 

 
5. If you want the e-file to only include employees for a specific state, enter the state in 

the State Filter field. The generated export file will include only those employees with an 
entry for the specified state. Leave this field blank to include all employees. Note: Entry 
in this field is required if you will be filtering by Local Code. 

 
6. If you selected to filter employees by state and also want to filter employees by local 

code, enter the local code in the Local Code Filter field. Press F4 to select from a list of 

valid local codes for the specified state. The generated export file will include only those 
employees with an entry for the specified state and local code. Leave this field blank to 
include all employees for the specified state or, if not filtering by state, all employees, 
regardless of state/local code. 

 
7. Click Export. The Save Export File As window displays. 

 
8. Save the text file to a location on your network, either accepting the default file name or 

entering a new file name as needed. The system saves the file and a message displays 
informing you of the number of Federal W-2 records that were processed. 

 



 

9. Click Close. You are returned to the PR Generate W-2 e-File form. You can now submit 

your file electronically to the Social Security Administration (SSA). 
 

Note: If you need to print employee copies of W-2s, use the PR W2 Employee Copies report 

(accessible from the Payroll Reports menu or from the PR W-2 Process form by 
selecting Options > Reports > PR W2 Employee Copies. This report is intended for printing 
employee copies (B, C, 2) only; it cannot be used for W-2 paper filings. 
 
Federal, State, and Local Filing through Aatrix 

 

1. Go to Tasks | Launch Aatrix and eFile 

 

2. Enter Tax Year, select form, then click Continue  

 



 

This will launch Aatrix and the W-2/1099 Preparer form 

 

 

3. Within Aatrix you will be asked to verify employee Information. If any information is 

incomplete the record will appear in Red. You will continue to click Next until the W-2 is 

ready to print or eFile.  

4. Once you have completed these preparations you will see for electronic filing. 

 

 

 

 

 

 

 
 



 

5. You can print the W-2 through Aatrix at no charge.

 
  
 
Here's why W-2s print the way they do...  

 If the employee paid taxes to one state/locality: A single page is printed that contains 

the Federal Copy B, Employee Copy C, and State Copy 2  

 If the employee paid taxes to multiple states/localities: Multiple pages print that 

contain the Federal Copy B, Employee Copy C, and each applicable state/local total; all 

Copy 2s print  

 
W2s print on a blank, perforated form with instructions on the back. There are 4 W-2s per page, 
and each employee will have his/her own page(s).  
  

6. Once finished with printing, proceed through Aatrix and follow the prompts to 

electronically file if needed. 



 

 

Affordable Care Act 
READ 

Users should be familiar with IRS definitions and requirements for ACA reporting before using 
Vista to enter ACA data and generate reports. For more information, visit the Internal Revenue 
Service website and search for "Instructions for Forms 1094-C & 1095-C". ACA processing is 
only available for companies where the Default Country setting on the HQ Company 
Setup form is US.  

  
STEP 1 - Enter Tax Year and Review ALE Part 1 & 2 Sections  

1. From the Payroll module's Programs folder, open the PR ACA Process form.  

2. In the Tax Year field, enter the current tax year.  

3. Save the record.  

4. Review and modify the employer information (Part 1) on the Info tab as needed. The 

EIN number should not contain dashes.  

5. Check the boxes as needed in Part 2:  

  

- Is Member of Aggregated ALE Group: Select this checkbox to indicate that the 

employer is a member of an Aggregated Applicable Large Employer group.  

- Qualifying Offer Method: Select this check box to indicate that the Applicable Large 

Employer (ALE) Member is both eligible for and using the Qualifying Offer Method for 

one or more full-time employees.  

- 98% Offer Method: Select this check box to indicate the Applicable Large Employer 

(ALE) Member is eligible to use the 98% Offer Method.  

6. Save the record.  

  
 
STEP 2 - Define ALE Member Info - Monthly Information  
The ALE Member Info - Monthly tab allows you to capture data necessary to produce part 3 of 

the 1094-C.  

1. On the PR ACA Process form, click the ALE Member Info - Monthly tab.  

2. In the MEC Offer Indicator column, check the All box for all months, or individual 

months as needed.   

3. In the Full Time Empl Count and Total Empl Count Columns, enter the correct 

counts.  

4. Check the Agg Group Indicator box if the Is Member of Aggregated ALE Group box 

is checked on the Info tab. This indicates the months the employee was a member of an 

ALE group.  

  
 

http://www.irs.gov/
http://www.irs.gov/


 

STEP 3 - Define ALE Group Members  

1. On the PR ACA Process form, click the ALE Group Members tab.  

2. In the Seq field, enter a plus sign or type New.  

3. In the Other Member PRCo field, press F4 to select one from a list. Leave this field 

blank if the company has not been set up in the HQ Company Setup form.  

4. In the Other Member Name field, accept the default or enter the company name.  

5. In the Other Member EIN field, accept the default or enter the EIN number for the 

company.   

6. In the Other Member Rank field, enter a rank for each ALE member. The 1094-C report 

allows a maximum of 30 members, so if an ALE group includes more than 30 members, 

the report will use the ranking in this field to determine the top 30.  

7. Save the record.  

  
STEP 4 - Initialize Employees  
To initialize employees, follow the steps below. If you would rather enter the employee(s) 
manually, move to the next step.  
Employees can be initialized within the Payroll or Human Resources modules. If your company 
utilizes Vista's Human Resources module, it is the recommended method for initializing 
employees because more information, such as series codes, are included. The example below 
is completed within the Payroll module.  
  

1. From the Info tab on the PR ACA Process form, select Initialize ACA from 

the Tasks drop-down list. The PR ACA Initialize dialog displays.  

2. Select the module from which to initialize: Payroll or Human Resources. If Human 

Resources is selected, enter the HR Company and indicate whether to include 

dependents.  

3. Select Full Time or All Employees for initialization.  

4. In the 1094-C (All 12-months) section, if the boxes are checked the system will check 

the MEC Offer Indicator and the Aggregated Group Indicator in the 1094-C for all 12 

months.  

5. In the 1095-C (All 12-Months) section:  

  

- Offer Code: If you are initializing from Payroll, select an IRS 1095-C series one offer 

code from the Offer Code drop-down list to designate the coverage offer. If you are 

initializing from Human Resources, ignore this field. The data will be pulled automatically 

from the ACA History tab on the HR Resource Master form.  

  

- Self Cost Only: If you offer self-cost only coverage, enter the employee share of the 

cost for that coverage. Leave the field blank if you do not offer self-cost only coverage.  



 

 - 4980H Safe Harbor Code: Select an IRS 4980H Safe Harbor code from the drop-

down list that will default for all employees. Employees with other codes will need to be 

edited manually.  

6. Click Initialize.  

  
STEP 5 - Enter an Employee Manually and Make Edits to Employee Information  
If you choose not to initialize employees, you must add them manually.  

1. On the PR ACA Process form, click the Employees tab.  

2. To add an employee, enter the employee ID in the Employee field or press F4 to select 

the employee from a list. To edit an employee, double-click an employee to open the PR 

ACA 1095-C Employee form and make changes as needed.  

  
 
STEP 6 - Print ACA Forms & Electronically File 

7. Click Tasks | Launch Aatrix Print and eFile 

 

 

 

 

 

 

 

 

 



 

8. Enter Tax Year, select form, then click Continue 

 

 

9. Within Aatrix you will be asked to verify employee Information. If any information is 

incomplete the record will appear in Red. You will continue to click Next until you have 

made all needed corrections 

 

 



 

Once you have completed these preparations you will see options for electronic filing. 

 

 

10. You can now proceed with printing each of your reports  

 

11. Once finished with printing, proceed through Aatrix and follow the prompts to 

electronically file if needed. 

 

REVIEW 

EFILE ACA REPORTS USING AATRIX 

YEAR-END ACA FREQUENTLY ASKED QUESTIONS ACA PAYROLL CHECKLIST 

VISTA HUMAN RESOURCES: HR ACA PROCESSING - SETUP AND FAQS, 

TROUBLESHOOTING ACA AND OTHER ACA QUESTIONS 

 



 

1099 

Review 1099 Vendors 

READ 

1099 types should already exist (they are created when you system is setup). When printing 
1099’s or filing them electronically, the system includes totals accumulated under 1099 types 
“MISC”,“NEC”, “INT”, and “DIV” only.  
 For each vendor that is 1099 reportable, verify that the vendor has been properly configured.  

1. From the Accounts Payable module's Programs folder, open the AP Vendor Master 

form.  

2. Click the Add'l Info tab.  

3. In the Vendor field, enter the vendor number you want to verify, or press F4 to select it 

from a list.  

4. Check the Subject to 1099 Reporting box. When checked, all new AP transactions will 

default with the 1099 box checked. Any transaction entered previously must be edited 

manually.  

5. If the 1099 goes to a different address, provide a sequence number in the Mailing 

Address Seq field, or press F4 to select it from a list. If the address you want is not 

available, you can create additional addresses using the Add’l Addresses tab.  

6. In the 1099 Type field, enter MISC (Miscellaneous Income), NEC (Non-Employee 

Compensation), INT (interest)  or DIV (ividends). These options are also available for 

selection by pressing F4.  

7. In the Box# field, enter the appropriate 1099 box number for 1099 reporting (based on 

the 1099 type entered above), or press F4 to select it from a list.  

8. In the Tax ID# field, enter the Federal Tax ID or Social Security Number.  

9. If applicable, enter the Proprietor name in the Proprietor field. This is used in a DBA 

situation with the format of last name, first name.  

10. If applicable, check the Include in 1099 Processing (ignore minimum) box to override 

the minimum reportable amount required for 1099 reporting on this vendor.  

11. Save the record.  

 

 
 
 
 
 
 
 



 

1099 Reports 
 
1099 reports can now be accessed from within the AP 1099 Processing Menu by clicking on 
Options | Reports then selecting your report 
 

 
 
 
AP 1099 Report 

The most detailed 1099 reconciliation report is the AP 1099 Report. It prints one page per 1099 
vendor – and shows you transactions that are flagged as 1099 type. The last page of this report 
also provides a form count that you can use while ordering forms. 
 
3. In the parameters form select  
    - Print 1099 Vendors Only  
    - Print 1099 Transactions Only  
5. Click Preview  

  



 

AP 1099 Totals Report  

This report shows you the final totals that will be included while printing and submitting 
electronic files and can be used to verify and make corrections to the totals within the AP 
Processing Menu as needed. 
1. Go to Accounts Payable | AP 1099 Processing | Options | AP 1099 Totals 
2. Enter 01/21 in Beginning Paid field  
3. Enter 12/21 in Ending Paid field  
4. Click Preview  

  

 
 
AP Vendor Payment History 

This is an additional report that is very helpful for balancing.  It shows all transactions for vendor 
whether marked as 1099 or not. Shows all transactions paid (1099/non-1099 transactions).  
1. Go to Accounts Payable | Reports | AP Vendor Payment History  
2. Enter 01/21 in Beginning Paid field  
3. Enter 12/21 in Ending Paid field  
4. Click Preview   

 
 



 

 
REVIEW 

HOW CAN I FIND OUT HOW MANY 1099 FORMS I NEED TO ORDER? HOW CAN I FIND A 

LIST OF 1099 VENDORS? 

 

1099 Processing 
READ 

STEP 1 - Edit Transactions  

1. From the Accounts Payable module's Programs folder, open the AP 1099 Processing 

Menu.  

2. Click Tasks | Edit Transactions. The AP 1099 Edit Transactions form displays.  

3. In the Year Ending field, enter the end month and year of the transactions you want to 

edit.  

4. In the Vendor field, enter the vendor number or press F4 to select it from a list.  

5. Select the transactions to display by checking the Select by Paid Mth box and providing 

a date in the Paid Month field, or by providing a date in the Expense Month field.  

6. Click Refresh. Transactions meeting the selected parameters display in the grid and 

may be modified using the 1099, Type, and Box# fields.  

  
STEP 2 - Edit Totals  

1. The AP 1099 Processing Menu opens with your totals displayed automatically 

 

The totals you see here are the amounts that will be printed on the 1099. You can edit the 
numbers, move the amounts to a difference box total or add a record here to print a 1099 for a 
vendor with amounts not tracked on the system.  



 

  
Other Data Field  

 Used to record information for state or local governmental reporting. Contact your state 

or local revenue department for filing requirements.  

 You may enter your routing and transit number (RTN) here.  

 Leave this field blank if you are not required to use it.  

 
2nd TIN Notification Box  

When checked, notification has been received by the IRS twice within three calendar years that 
this vendor has provided an incorrect TIN (Taxpayer Identification Number), and the 2nd TIN 
Notification box will be checked on Copy A of the 1099 form or a '2' printed in position 544 of the 
B record for electronic downloads. No further notifications will be sent by the IRS.  
   
When unchecked, no notification has been received by the IRS that this vendor has provided an 
incorrect TIN or, if notification has been received, you have not received more than one 
notification within three calendar years.  
  
 
STEP 3 – Print 1099 reports and Electronically File  
Vista provides options for printing 1099 NEC recipient copies and downloading a 1099 NEC 
electronic file that can be uploaded to the IRS website. All other 1099 types must be printed and 
electronically filed using Aatrix. 
. 

Federal 1099 NEC Printing through Vista 
 

1. Click on Options | Reports | AP 1099 Recipient Copies 
2. Enter the appropriate values into the fields and use the Preview, Print, or Export options 

to generate your recipient copies 
 

 



 

Federal 1099 NEC Electronic Filing through Vista 
 
1. From within the AP 1099 Processing Menu form Click Tasks | Download 

 

 

2. Fill in all required fields then click Download to retrieve your electronic file and upload it to the 

IRS website. Reminder: Vista only provides Federal NEC type electronic files. All other 1099 

types, and state/local electronic filing, must be done via Aatrix.  

 

 

 



 

Federal 1099 NEC Electronic Filing through Aatrix  
 
1. From within the AP 1099 Processing Menu form Click Tasks | Download 

 

 
 

 

2. Click Launch Aatrix 

 

 

 

 



 

3. Enter Tax Year, select the form you’d like to work on, then click on Continue 

 

 

 

 

 

 

 

 

 

 

 

 



 

This will launch Aatrix and the W-2/1099 Preparer form 

4. Within Aatrix you will be asked to verify vendor Information. If any information is 

incomplete the record will appear in Red. Make needed corrections and proceed by 

clicking Next until the 1099 is ready to print or eFile. 

 

 

Once you have completed these preparations you will see the following information regarding 

electronic filing. 

 

 
 

 

 

 

 

 

 

 

 



 

5. You can now proceed with printing each of your reports 
 

 

 
 

 

6. Once finished with printing, proceed through Aatrix and follow the prompts to 

electronically file if needed 

 

 

 



 

Fiscal Year/Month End Close 
READ 

1. Enter upcoming GL Fiscal year   
1. Go to General Ledger > Programs > GL Fiscal Years (Grid Tab)  
2. Click New Record  
3. Enter Fiscal Year Ending date (upcoming year)  
4. Enter Begin Month  
5. Click Save  

  
2. Perform Month-End Process  
Complete the month of December by closing the sub ledgers and then the general ledger.  

1. Go to General Ledger > Programs > GL Month End Close  
2. Enter 12/23 in the Close through Month field  
3. Click Close Check button  

4. Review items in the table and take action on necessary items  
5. Once items are corrected, click OK  
6.  Click Close General Ledger  
7.  Click Close Check button  

8. Review items in the table and take action on necessary items  
9. Once items are corrected, click OK  

  
3. Review GL COA for Single Profit/Loss Account   

1.  Go to General Ledger > Programs > GL Chart of Accounts (Grid tab)  
2. Right-click on grid and select Filter Bar  
3. Click Account Type from the Filter bar  
4. Select P-Profit/Loss  
5. Review list to make sure your Chart of Accounts has only one Profit/Loss, Retained 
Earnings account  
 

REVIEW 

CLOSING THE FISCAL YEAR IN GENERAL LEDGER 

 

 

 

 

 

Beginning Balance Update/Adjustment Period 
READ 

 
1. Run Beginning Balance Update   
2. Go to General Ledger > Programs > GL Beg Balance Update  
3. Enter 12/23 in Initialize Fiscal Year Ending field  
4. Click Initialize button  

 
5. GL Adjustment Period Entries   



 

6. The system does not have a ‘13th period’. However, adjustment period or year-end 
entries can be tagged by checking the box that these are Adjustment Period Entries 
when creating a GL Journal Entry Batch.  

7. Go to General Ledger > Programs > GL Journal Transaction Entry  
8. Create a New Batch  
9. Enter the Batch Month  
10. Check the Adjustment Period Entries checkbox  
11. Click OK  

12. Enter adjustment entries that are needed  
 

13. Run Trial Balance Report   
14. Go to General Ledger > Reports > GL Trial Balance  

15. Enter the report parameters. To see adjusting entries in the trial balance totals, check 
the Include Year- End Adjustments box  

16. Click Preview (or Print)  

 

REVIEW 

VISTA GENERAL LEDGER - GL BEGINNING BALANCE UPDATE (TUTORIAL) 

ADJUSTMENT PERIOD ENTRIES IN THE BATCH SELECTION FOR JOURNAL 

TRANSACTIONS 



 

Year End Resources & Information 
       

Viewpoint Business Forms 

ACA, W-2, 1099 tax forms and laser checks fully compatible with your Viewpoint 

software. 

Call 800.825.8649 or visit the Viewpoint Business Forms website. 
 

AccuWage Online 

Access this free application from Social Security Administration that enables you 
to check W-2 (Wage and Tax Statement) and W-2c (Corrected Wage and Tax 
Statement) Wage reports for correctness before uploading them to Business 
Services Online. 

We recommend that you go to AccuWage to run your electronic file through their 
test to determine if there are errors and wait to submit the electronic file until all 
W-2s are issued in case there are corrections needed. 

Customer Portal Download Center 

All Viewpoint software updates and related documents are now available directly 
from the Products page under Vista on the Customer Portal. This includes new 
releases, service packs and tax updates (where applicable) for all Viewpoint 
Construction Software products, as well as release notes and installation 
manuals. 

Payroll Reference Guide 

From viewing the 941 to the final electronic file, Quarterly & Year-End Tax 

reports will help you meet your filing needs. Find out about these reports and 
other payroll tax filings by visiting the Vista – Payroll Reference Guide.  
 

Due Dates 

January 31, 2024, is the deadline to file W-2s. January 31st is the deadline to 
distribute Forms W-2 to employee(s). 

 

2023 filing due dates for form 1099-NEC is due to the IRS and the payee by 
January 31, 2024. 

 

Affordable Care Act (ACA) Paper IRS returns for 2023 must be filed by February 
28, 2024. Electronic IRS returns for 2023 must be filed by March 31, 2024 
 

Regulatory Updates vs Tax Updates 

It is important to upgrade Vista to the current year end supported versions 2023 
R1 and 2023 R2 in order to install the regulatory updates that will impact your tax 
forms. You can process checks at the beginning of the year in January as long as 
the tax update has been downloaded, installed and initialized. However, in order 

https://store.viewpointforms.com/Store/Browse/Page/Landing
https://www.ssa.gov/employer/accuwage/index.html
https://cdnedge.viewpoint.com/lms/2017_Reference_Guides/Vista_PR_RefGuide/story_html5.html


 

to generate your tax forms Vista must be on a supported version in order to install 
the year end regulatory update prior to generating your tax forms. 
 

Filing of W-2s for tax year 2023 

Federal W-2s can be printed and filed electronically via Vista. All state and local 

W-2s must be printed and filed through Aatrix. 

 

Filing of 1099s for tax year 2023 

Federal NEC 1099 recipient copies can be printed via Vista and federal NEC 
electronic files can be downloaded within Vista. 

All other types including DIV, INT, MISC and NEC can be printed and filed 
electronically via Aatrix. State 1099s can also be filed via Aatrix. Vista has never 
offered this state filing option, and this is one of the great things about our 
partnership with Aatrix.  

Internal Revenue Service 

Publication 15 (2018), (Circular E), Employer Tax Guide Publication 1220 - 

Specifications for Electronic Filing of Forms 

Form 4419 Application for Filing Information Returns Electronically (FIRE) - 
needed for 1099 Filing 

Users should be familiar with IRS definitions and requirements for ACA reporting 
before using Vista to enter ACA data and generate reports. For more information, 
visit the Internal Revenue Service website and search for "Instructions for Forms 
1094-C & 1095-C". 

 
Viewpoint Help has recently made some updates that Vista users will want to check out! 
The help website is designed to give you access to comprehensive product documentation 
from a single location. Here are just five reasons you should check it out today: 

1. Access: You can easily access Help for multiple Viewpoint products, 

including Viewpoint HR Management for Vista, Viewpoint Financial Controls, 
Viewpoint Field Management, and Vista Field Service.  

2. Search: You can search across Help for multiple Viewpoint products and filter 

your search by product or other categories. For example, you could filter to 
show only Help pages with videos. 

3. Create a PDF: You can generate a PDF of an individual Help page or an 

entire section of the Help. 
4. Share: You can quickly share a Help page via email or social media.  

 

https://www.irs.gov/publications/p15
https://www.irs.gov/pub/irs-pdf/p1220.pdf
https://www.irs.gov/pub/irs-pdf/p1220.pdf
https://www.irs.gov/pub/irs-pdf/f4419.pdf
https://www.irs.gov/pub/irs-pdf/f4419.pdf
https://www.irs.gov/pub/irs-pdf/f4419.pdf
http://www.irs.gov/
https://help.viewpoint.com/


 

Year End Updates  

 

It’s not too early to plan for year-end now. Vista requires that 

you upgrade to one of the two latest versions to be prepared 

for year-end reporting. 

 

You will need to be on version 2023 R1 or 2023 R2 (released 

later this year) for year-end. These versions require Windows 

Server 2012 (or later) and SQL Server 2016 (or later), so if 

you are currently on an older version of Windows or SQL, you 

will need to upgrade either or both of those before year-end. 

Unfortunately, Viewpoint does not have a service to upgrade 

Windows or SQL as both are Microsoft products. However, 

we can help migrate Vista to a new server with newer 

versions of Windows and SQL. 

 

If you need Viewpoint help with your update or migration to a 

current version we are here for you. Start scheduling now 

because available slots fill up quickly. To sign up for a time 

slot for Viewpoint assistance on upgrades (if your system 

meets our current requirements) or to migrate your ERP to a 

new server, take two minutes to watch this explainer video. 

 

Watch the Video 

 

 

https://info.viewpoint.com/Landing-Pages---Network_Submit-a-Deployment-Case-with-Support.html?utm_source=network&utm_medium=network
https://info.viewpoint.com/Landing-Pages---Network_Submit-a-Deployment-Case-with-Support.html?utm_source=network&utm_medium=network


 

Viewpoint Academy  
 

The Viewpoint Academy offers guided role-based learning specific to your 

position. These training programs are designed to make you the expert your 

company needs. From the home screen, simply click on Learning Plans and 

then select your role. 

 

Did you know that all of the Viewpoint users at your company have access 

to free, role-based learning plans in Viewpoint Academy? Training your new 

employees on Viewpoint solutions has never been easier 

 

Does anyone in your office need an introduction to Construction 

Accounting?  Have them register for this free, eLearning class in Viewpoint 

Academy. In just two hours you’ll cover these accounting concepts: Job 

Costing, Committed Costs, WIP Schedules, Progress Billing, and more.  

 

Viewpoint Academy has a separate login from the Customer Portal and 

the Viewpoint Network. Your email address is your username. If you did not 

receive a welcome email with a password, click the “forgot password” link on 

the Academy sign-in screen. You will receive an email with instructions to 

set your password. 

 

 

Training or Academy Questions? 

Email: viewpointacademy@viewpoint.com 

 

 

https://academy.viewpoint.com/
https://academy.viewpoint.com/pages/52/viewpoint-roles
https://academy.viewpoint.com/
https://academy.viewpoint.com/learn/course/external/view/elearning/2345/introduction-to-construction-accounting
https://support.viewpoint.com/s/
https://www.viewpoint.com/the-viewpoint-network
mailto:viewpointacademy@viewpoint.com


 

 

 

Preparing for Year-End 

 
 QUARTERLY BALANCING – REPORTS 

 

 INITIALIZE W2S IN PR W2 PROCESS 

 

 VERIFY EMPLOYEE INFORMATION 

 

 FIND OUT HOW MANY W2S YOU NEED BY RUNNING W-2 PREVIEW 

 

 PRACTICE GENERATING TAX FORMS USING AATRIX TEST DRIVE MODE 

 

 ORDER YOUR FORMS FROM VIEWPOINT BUSINESS FORMS 

 

 VERIFY VENDOR INFORMATION (ADDRESS/RECEIVE 1099S CHECKBOX) 

 

 READ/REVIEW/WATCH BONUS CHECKS PROCESSING 

 

 READ/REVIEW/WATCH THIRD PARTY SICK PAY TRAINING 

 

 READ/REVIEW/WATCH SPLIT MONTH PAY PERIOD SETUP 

 

 BALANCE AND RECONCILE LEAVE 

 

 SETUP NEW LEAVE CODES 

 

 VERIFY EMPLOYEE LEAVE OVERRIDES (CORRECT EXISTING/ADD NEW) 

 

 UPDATE BENEFITS HR TO PR 

 

 

 

 



 

 

Timing of Payroll Year End Tasks 
 

Warning: Once tax routine updates are initialized the changes are effective the next time 

you process payroll, regardless of the dates on the check. Tax updates do not affect 

previously issued checks. 

 

Q: Do I need to install the year-end regulatory update before I print W-2s or 
1099s? 

A: Yes, you must install the year-end update before you process or print 
government forms or reports. 

 
Q: What do I need to do before I process checks for the New Year?  

A: Install the Year End service pack update. Print and post all checks for 
the old year. Download and initialize taxes updates. 

 

Q: What do I need to do before I generate W-2s?  

A: Print and post all checks for the old year. Install the year-end service 
pack update. 

 
Q: What are some examples of year-end task workflow?  

A: Print and post old year checks. Initialize taxes. Install the year-end 
regulatory update. Enter time, process, and print New Year checks. 
Generate W-2s. 

 

Q: When should I initialize the Payroll tax updates for the New Year’s tax 
changes? 

A: Download and update taxes after you print and post the last payroll of 
the old year and close the year, but before you process checks for the first 

payroll of the New Year. Although initializing tax routine updates makes 
tax rates current for the New Year, you may still need to change local 
taxes and rates specific to your company such as state unemployment 
rates. 

 

Q: Can I process payroll for the New Year before I print W-2s? 

A: Yes, as long as you have initialized tax updates and installed the year-
end update. You can then process payroll for the New Year and print W-2s 
based on prior year totals.



 

 

 

Payroll Year End Checklist  
 
 

 COMPLETE FINAL PAYROLL OF YEAR 

 BALANCE THE ACCUMULATIONS   

 COMPLETE QUARTERLY FILING AS NEEDED  

 RUN-YEAR END REPORTS AS NECESSARY  

 COMPLETE ACA PROCESSING AND FILE  

 PERFORM W2 PROCESSING AND FILING  

 RUN LEAVE CODE RESET  

 VISIT THE CUSTOMER PORTAL AND REVIEW 

VISTA’S AVAILABLE DOWNLOADS AVAILABLE 

SOFTWARE AND TAX UPDATES  

 UPDATE NEW RATES AND LIMITS  

 



 

 

 

Accounts Payable Year End Checklist  
 
 

 RUN AP 1099 REPORT  

 RECONCILE  

 EDIT TRANSACTIONS AND TOTALS  

 PROCESS 

 PRINT REPORTS  

 EFILE  

 

 
 
 
 
 
 
 
 



 

 

 

General Ledger Year End Checklist  
 
 

 CREATE THE NEW FISCAL YEAR IN GL FISCAL YEARS  

 MAKE GL JOURNAL ENTRY ADJUSTMENTS AS 

NEEDED 

 CLOSE THE FINAL MONTH IN GL MONTH END CLOSE  

 RUN THE GL BEGINNING BALANCE UPDATE   

NOTE: IF GL JOURNAL ENTRY ADJUSTMENTS ARE 

NEEDED AFTER CLOSING THE MONTH, YOU MUST 

REOPEN THE MONTH, MAKE YOUR GL JOURNAL 

ENTRIES, AND RUN THE GL BEGINNING BALANCE 

UPDATE AGAIN 

 

 



 

 

 
KNOWLEDGE BASE ARTICLES 

 

YEAR END W2 PROCESSING STEPS THROUGH AATRIX ID:  000138077 
 

AATRIX WORKFLOW DOCUMENT ID: 180118124248830 

DOES VISTA PROVIDE A PAYROLL YEAR END WORKFLOW CHECKLIST 

ANYWHERE? 
ID: 190912222103455 

BALANCING PR EMPLOYEE ACCUMULATIONS ID: 170808113917520 

BALANCING THE PR EMPLOYEE ACCUMULATION REPORT TIPS ID: 160805122832731 

EMPLOYEE ACCUMULATIONS REPORT ID: 160413173850006 

REASONS YOUR PR EMPLOYEE ACCUMULATIONS COULD BE OUT OF 

BALANCE 
ID: 170811101802218 

VISTA PAYROLL: REPORTS - BALANCING QUARTERLY  ID: 170110211445181 

VISTA PAYROLL: QTR & YEAR END – BALANCING ID: 170113065319668 

REPORTS TO USE TO BALANCE PAYROLL FOR QUARTERLY AND YEARLY 

PROCESSING 
ID: 150925959335032 
 

PAYROLL: QTR & YEAR-END - UNEMPLOYMENT ID: 170110212715849  

YEAR-END BONUS CHECKS FREQUENTLY ASKED QUESTIONS ID: 171013165943731  

VISTA YEAR-END TAXABLE FRINGE FREQUENTLY ASKED QUESTIONS ID: 171013142826911  

YEAR-END LEAVE RESET FREQUENTLY ASKED QUESTIONS ID: 171006104350535  

RESETTING YEAR END LEAVE ID: 150925473362100 

YEAR END PAYROLL CHECKS LAST WEEK OF DECEMBER ID: 151123094925320 

YEAR-END TAX UPDATES FREQUENTLY ASKED QUESTIONS ID: 171020095049670 

HOW DO I INITIALIZE MY TAX ROUTINES?   ID: 181219113732430 

HOW TO CHANGE THE NEW PERCENTAGE OR RATE FOR STATE 

UNEMPLOYMENT (SUTA) 
ID: 180108111711545 

YEAR-END THIRD PARTY SICK PAY FREQUENTLY ASKED QUESTIONS ID: 171013140503088  

3RD PARTY SICK PAY ON THE W-2 ID: 170126203157947 



 

 

 

WHAT DOES THE THIRD PARTY SICK PAY INDICATOR IN THE W-2 

PROCESS FORM DO? 
ID: 160420140828302 

YEAR-END W2 FREQUENTLY ASKED QUESTIONS ID: 171006104350535 

LIST OF KNOWLEDGE BASE ARTICLES ON W-2S ID: 160818191338561 

HOW CAN I FIND OUT HOW MANY W-2 FORMS I NEED TO ORDER? ID: 150925916516764 

YEAR END 1099 PROCESSING STEPS THROUGH IN VISTA USING AATRIX ID: 000138080  

EFILE ACA REPORTS USING AATRIX ID: 190314174056500 

YEAR-END ACA FREQUENTLY ASKED QUESTIONS ID: 171013110022940  

ACA PAYROLL CHECKLIST ID: 151113103508951  

VISTA HUMAN RESOURCES: HR ACA PROCESSING - SETUP AND FAQS, 
TROUBLESHOOTING ACA AND OTHER ACA QUESTIONS 

ID: 170922113553564 

YEAR-END GL FREQUENTLY ASKED QUESTIONS ID: 171006125940582  

CLOSING THE FISCAL YEAR IN GENERAL LEDGER ID: 160413093418712 

VISTA GENERAL LEDGER - GL BEGINNING BALANCE UPDATE (TUTORIAL) ID: 161114151714057 

ADJUSTMENT PERIOD ENTRIES IN THE BATCH SELECTION FOR JOURNAL 

TRANSACTIONS 
ID: 160119140159178 

YEAR-END 1099 FREQUENTLY ASKED QUESTIONS  ID: 171006122420130 

WHAT TYPES OF 1099S DOES VISTA SUPPORT? ID: 180409184822685 

VENDORS NOT SHOWING UP ON 1099 REPORTS ID: 160122132951406 

HOW CAN I FIND OUT HOW MANY 1099 FORMS I NEED TO ORDER? ID: 150925886152099 

HOW CAN I FIND A LIST OF 1099 VENDORS? ID: 170130113257621 

 


